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CCH® ProSystem fx® Knowledge Coach
Welcome to 2020 Knowledge-Based AuditsTM of International Entities for Knowledge Coach
This document provides important information about the 2020 release of Knowledge Based AuditsTM of International Entities. Review this
information carefully. If you have any questions, additional information is available on CCH Support Online.

New in this Release
Knowledge-Based Audits of International Entities
This title can be installed on CCH® ProSystem fx® Engagement v2018 by first installing the CCH ProSystem fx Engagement v2018.2.4 Update
for Knowledge Coach. The latest update can be downloaded here. This update allows you to use the 2020 content without installing
Engagement v2019 until your firm plans to update.
This title is designed to help the auditor efficiently and effectively perform financial statement audits of international commercial entities in
accordance with International Standards on Auditing (ISAs) promulgated by the International Auditing and Assurance Standards Board
(IAASB). The knowledge-based audit is a risk-based methodology that emphasizes using knowledge of the entity to make risk assessments
in connection with a financial statement audit. This allows the auditor to more appropriately focus audit efforts on those areas which, in
the auditor’s judgment, are the most significant and pose the most risk of material misstatement to the financial statements. The KBA
methodology drives audit strategy that is scalable to any size engagement, in any industry. It helps the auditor achieve efficiencies and
effectiveness that result in overall cost savings by reducing the tendency to over-audit. These workpapers include practice aids, audit
programs, checklists, questionnaires, workpapers, sample correspondence, and sample auditor's reports that take the practitioner through
an engagement from the initial evaluation of an entity to the issuance of the auditor's reports on the financial statements. These
workpapers also include interpretive guidance, workpapers, review programs, checklists, and correspondence necessary to complete
reviews of interim financial information in accordance with International Standard on Review Engagements (ISRE) 2410, Review of Interim
Financial Information Performed by the Independent Auditor of the Entity, should this be required as part of the engagement.
The operations of international entities are often unique and complex and require specialized accounting and auditing knowledge.
Conducting audits of international entities requires the exercise of the auditor’s professional judgment. This document is published for the
purpose of communicating to users of the toolset the updates and enhancements included in the current version. This document is not,
and should not be used as, an audit program to update the audit documentation of an engagement started in a previous version of this
product.
This document is published for the purpose of communicating the updates and enhancements included in the current version to users of
the toolset. This document is not, and should not be used as, an audit program to update the audit documentation of an engagement
started in a previous version of this product.
If you are updating from a previous version of this title, refer to the Knowledge Coach User Guide, Chapter 12. The guide is found on the
Engagement File Room Help menu.

The 2020 documents include CCH® Accounting Research® material links to specific guidance that provide instant access to detailed analysis
related to the steps and processes discussed in the workpapers.
2020 Edition of Knowledge-Based Audits of International Entities
This edition features numerous enhancements, including:
•

Combining complex and noncomplex forms (KBA-201N, KBA-302N, and KBA-401N) giving the auditor the option to memo or
complete the detailed table for each section based on tailoring.
Roll Forward Note: If you have used a noncomplex document in your prior engagement, before rolling that file forward, you must
add the complex document to your engagement binder to retain the data from the noncomplex document, then remove these
workpapers from the prior year binder after you have rolled the binder forward.
If your binder has already been finalized and you don’t want to unfinalize the binder to insert the complex document before you roll
forward from the 2018 version, make a copy of your finalized binder, insert the applicable complex documents, and then roll
forward the copied binder to the 2019 title version. After roll forward, remember to delete the copied prior year binder from your
file room. Doing this will retain the data into the 2019 combined versions.
Alternatively, copy and paste the data from the prior year noncomplex document from the prior year binder after you roll forward
into the current combined versions. The noncomplex document will roll forward as an obsolete workpaper with no data. Remove it
after you have rolled forward your binder. Refer to your prior year binder for data in the noncomplex document.
For ”update knowledge coach content,” insert the complex version of the workpaper prior to updating to retain information from
the now obsolete noncomplex version. We recommend publishing the noncomplex versions prior to “update knowledge coach
content” so that you can access the data, since the noncomplex version will be obsolete after updating.

•

Streamlining entity information from KBA-302 Understanding the Entity and Its Environment by removing Section I. This
information is available in KBA-200 Entity Information and Background.

•

Adding flow of columns “Nature of Other Services” and “Firm Personnel Overseeing the Service” from KBA-101 Overall Audit
Strategy to AID-201 Non Attest Services Independence Checklist.

•

Adding the table “Prior Year Substantive Matters and Significant Findings” to KBA-102 Engagement Completion Document. This
table is only user entry and is available if you would like to document prior year matters or findings.

•

Adding the flow of question “Describe the users or expected users of the financial statements (e.g., owners, stakeholders, lenders)"
from KBA-200 Entity Information and Background to KBA-301 Worksheet for Determination of Materiality, Performance Materiality,
and Thresholds for Trivial Amounts.

•

Adding flow of Component Units from AID-603 Component Identification and Analysis to KBA-301 if the user has noted the
Component Unit as being “Significant” in one of the four columns in AID-603.

•

Adding a new column in KBA-301 in step 4: Determination of the Threshold for Trivial Amounts so that you can document the trivial
amount. You must manually key in this number based on the calculation, as this new column triggers the flow of the trivial amount
to the materiality tables located in other forms.

•

Adding a new table to trigger flow of items identified in KBA-400 Scoping and Mapping of Significant Account Balances, Classes of
Transactions, and Disclosures. All items identified in table 2 or 3 of KBA-400 flow to this new table, and then you can decide which
to flow to KBA-103. This change helps remove duplication in KBA-103.

•

Modifying headers and related instructions regarding compensating controls in KBA-401 Understanding Entity-Level Controls. Due
to modifications, you can no longer show or hide columns in the detailed table based on internal control tailoring questions from
AUD-100. Note that column 7 will reset on roll forward due to the content changes.

•

Modifying headers and adding one new column (If Controls are Not Effectively Designed and Implemented or Are Not Operating
Effectively, Describe the Risks of Material Misstatement) in KBA-402 Understanding General Controls for Information Technology in
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the “less complex” table. This new column contains a dynamic list of risks noted in the engagement which is similar to the
functioning of KBA-400 and KBA-40X series forms.
•

Adding two new Potential Error Diagnostics in KBA-502 Summary of Risk Assessments that trigger when you:
–

Add a specific risk in the risk pane, but document that both Inherent Risk and Control Risk are low.

–

Select Combined under the Planned Audit Approach column and you haven’t noted that they are performing an integrated
audit and not testing internal controls overall for a particular audit area in AUD-100.

•

Adding a table to both KBA-902 Audit Review and Approval Checklist and KBA-905 Review and Approval Checklist: Interim Review of
Financial Information to document a concurring partner review, if applicable. A tailoring question has also been added to AUD-100
that will have show/hide functionality on this table in both forms.

•

Adding a new missing workpaper or unnecessary workpaper diagnostic related to AID-603 based on your response to tailoring
question “Does the entity have multiple components, multiple locations, or segments that are included in the scope of our
engagement?”

•

Adding a new audit area, Business Combinations, throughout the title, and adding AUD-822 Audit Program: Business Combinations.

•

Rewording audit area “Journal Entries and Financial Statement Review” to “Journal Entries.” The Financial Statement Review steps
are no longer included in AUD-814. These steps are now in the new AUD-909 Audit Program: Financial Statement Review form.

•

Adding new steps and tailoring questions to AUD-803 Audit Program: Accounts Receivable and Revenue for revenue related
procedures.

•

Adding new steps and tailoring questions to AUD-807 Audit Program: Property and Equipment, and Depreciation and AUD-811
Audit Program: Debt Obligations to document new/revised lease guidance.

•

Enhancing instructions and procedures throughout the toolset to improve workflow.

•

Adding new AUDs and AIDs as follows:
–

AUD-604A Audit Program: Using the Work of a Management's Expert (In Accordance with ISA-540R

–

AUD-822 Audit Program: Business Combinations

–

AUD-909 Audit Program: Financial Statement Review

–

AID-835 Deferred Tax Analysis

–

AID-846 Journal Entry Testing Worksheet

–

AID-910 Analytical Procedures: Final Account Balance Analysis

–

COR-901A Management Representation Letter - ISA 540 (R)

Click here for the 2020 Audits of International Entities Title Overview for Knowledge Coach Users.
In addition, forms and practice aids throughout have been updated to include new examples and tips, and where applicable, to take into
account new literature, standards, and developments reflected in the following current audit and accounting guidance:
•

International Standards on Auditing (ISA)

•

ISA 315 (Revised), Identifying and Assessing the Risks of Material Misstatement

•

ISA 540 (Revised), Auditing Accounting Estimates and Related Disclosures
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Important:
•

Save changes to workpapers before closing the workpaper or the binder to ensure data is correctly updated.

•

If Microsoft® Word crashes when using Knowledge Coach, before closing the binder, use the Save Knowledge Coach Answers
option in the binder view under the Tools menu. This step saves all data within tables.

•

You can view other Knowledge Coach best practices on our Web site.

System Requirements
This title requires the 2019 Financial Statement Base title. The 2019 Financial Statement Base title must be installed with one of the
following versions of Engagement and Knowledge Coach:
•

Engagement and Knowledge Coach v2018 with CCH ProSystem fx Engagement v2018.2.4 Update or later, available here. To identify
the version you are running, please go to the Help > About window in the application.

•

Engagement and Knowledge Coach v2019 or newer.

If you are upgrading from Engagement v7.1 or older, please contact Technical Support.
A minimum of 4GB of RAM is required for optimal performance when opening and navigating Knowledge Coach workpapers.

License Requirements
This title requires the Knowledge-Based Audits of International Entities license. Staff members who do not have a license for this title
cannot use Knowledge Coach functionality in workpapers.
For information on updating your licensing, see How do I add or update CCH ProSystem fx Engagement Licenses? on our Support Web site.
For more information on assigning licenses, see How do I assign Engagement Licenses? on our Support Web site.

Download Instructions
To use this title with Engagement and Knowledge Coach v2018, apply the CCH ProSystem fx Engagement v2018.2.4 Update to all
computers, including Admin and terminal servers, before installing the title. Review the update's release notes for more information.
To download this title:
1.

Navigate to the Knowledge Coach Updates section of the Engagement Support Web site.

2.

Select the Knowledge Coach Series. The series are arranged by title type, then industry.

3.

Click Download File next to the title you want to download.

Note: Occasionally the content package file (.KCP) downloads with the extension changed to ZIP. If this occurs, change the extension of the
downloaded file to KCP, using all capital letters.
You must install the 2019 Financial Statement Base title before installing the 2020 Knowledge Based Audits of International Entities.
The Financial Statement Base title is also available on the Knowledge Coach Update Web site.
The Knowledge Coach Content Package (KCP) download is a proprietary file that must be installed from within Engagement. Save this KCP
file to a location on your local drive, and follow the Installation Instructions in the article linked in the section below.
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Installation Instructions
See How do I add a new CCH ProSystem fx Knowledge Coach title to CCH ProSystem fx Engagement? for instructions on installing a new
Knowledge Coach title.

Online Permission Key
Permission key files can be downloaded from our Web site or when adding or updating the new licenses in Engagement v2018 and newer.
After updating the license file in the Engagement Admin module, licenses must be assigned to the staff member who will use 2020
Knowledge-Based Audits of International Entities.
If you have not already established a Single Sign-on (SSO) account with Customer Service, we urge you to do so at this time.

Using Your Knowledge Coach Content with CCH® Accounting Research Manager®
Accounting Research Manager (ARM) is the most comprehensive, up-to-date, and objective online database of financial reporting
literature. It includes all authoritative and proposed accounting, auditing, and SEC literature, plus independent, expert-written interpretive
guidance.
Available on ARM, the Knowledge-Based Audits of International Entities Guide helps you comply with the most recent professional
standards and guidance for conducting audits of international entities. It integrates practice aids, tools, and other resources with its
guidance. This publication supplements and complements the knowledge-based documents that are available in Knowledge Coach.
If you subscribe to an ARM library that includes International content, you can link directly to source material from Resources within
Knowledge Coach documents. These links have been updated to refer to the accounting standards under the FASB Accounting Standards
Codifications. Also, if you subscribe to the Knowledge-Based Audits of International Entities Guide on ARM, you can take advantage of
references to the guide material from within the Knowledge Coach documents.
With ARM, you maximize the efficiency of your research time, while enhancing your results. Learn more about our content, our experts,
and how you can request a free trial by visiting the Accounting Research Manager Web site. You can also access the Web site by selecting
Engagement > Binder Window > Shortcuts Bar > Guidance tab.

Using Your Knowledge Coach Content
To use your Knowledge Coach workpaper templates, do the following:

1.

Open a binder in Engagement.

2.

Select the workpaper tab into which you would like to insert the workpaper.

3.

Select New Knowledge Coach Workpaper from the toolbar or File menu.

4.

Select the new Knowledge Coach title with the content you would like to use. You can only select titles you have installed. The
information displayed changes to reflect the workpaper organization available for the selected title.

5.

Select the Knowledge Coach workpapers to insert into your binder, and then click OK.

6.

In the Selected Workpaper Properties window, add a workpaper index in the Index field and make any Name modifications that are
needed. You can also modify the tab location or the roll forward settings for each workpaper.

7.

Click OK. The integrated Knowledge Coach workpaper is now inserted into your engagement binder.

Note: For more information on how to use Knowledge Coach workpapers in your binder, see the Knowledge Coach User Guide.
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Additional Information on Knowledge Coach and the KBA Methodology
Knowledge-Based Audit (KBA) Methodology allows the results of one set of procedures to become the input for the next. The key
components of the KBA methodology include:
•

An overview that guides auditors through the methodology

•

Knowledge-based audit documents, integral to risk assessment and audit processes, which contain steps and procedures required
by ISAs

•

Customizable audit programs that take auditors through related steps and procedures

•

Practice aids to help auditors complete steps or processes outlined in the knowledge-based audit documents and audit programs

•

Auditor reports that provide a variety of sample auditor opinions on audited financial statements

•

Sample letters to be used to comply with ISA requirements and in other common situations

•

The International Auditing and Assurance Standards Board's (IAASB) Risk Assessment Standards - The practice aids and tools in the
2020 Knowledge-Based Audits of International Entities are designed around the IAASB’s risk assessment and clarified standards to
assist auditors of international entities by:
–

Facilitating compliance with ISAs

–

Encouraging more effective audits through tailored audit programs and comprehensive practice aids

–

Helping auditors to focus on and respond to identified audit risks

–

Enhancing audit documentation

CCH® ProSystem fx® Knowledge Coach
Knowledge Coach functionality allows auditors to use the Knowledge-Based Audit methodology more efficiently by eliminating the need for
duplicate entry of the same information, tailoring audit documentation to each particular engagement, and documenting the link between
risks identified and procedures performed. AUD-100 Tailoring Question is a document in Knowledge Coach that presents engagement-level
questions designed to aid in tailoring the engagement documentation to fit each client. Completing the questions helps the auditor avoid
duplication and unnecessary workpapers.
Note: Before you begin your audit, review the guidance in AUD-101 Overall Audit Program. This workpaper is your road map through a
Knowledge-Based Audit methodology. Start your audit with AUD-100 Tailoring Question Workpaper and AUD-101 Overall Audit Program.
•

Risks can be captured via the Risk Summary task pane from any Knowledge Coach workpaper by the current editor of KBA-502
Summary of Risk Assessments. This allows you to continuously assess risks during the engagement. Several workpapers prompt you
to consider the presence of risks, but the Risk Summary task pane must be used to document those risks. All documented risks flow
to the Risk Summary. To ensure risks show in findings tables, select the workpaper identified in field of the Risk pane.

•

Information Flow helps reduce the time spent duplicating information across forms. In addition, the flow of consistent information
ensures that information and updates to information are not missed between workpapers. Drill-down functionality helps you
navigate quickly to the source of the information, aiding in the review of the audit file.

•

Diagnostics help track unresolved issues like unanswered questions, incomplete risks, program steps not linked to risks or relevant
assertions, missing workpapers, and more.

•

Links to Accounting Research Manager (ARM), if you subscribe to an ARM library that includes audit content, link directly to source
material from Resources within Knowledge Coach workpapers. These links have been updated to reference the accounting
standards under the FASB Accounting Standards Codifications and the auditing standards issued by the AICPA. Also, if you subscribe
to the Knowledge-Based Audits of International Entities Guide on ARM, you can take advantage of links to the audit guide material
from within the Knowledge Coach documents.
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•

Interpretive Guidance is integrated in each Knowledge Coach template through the Tips view of each new task pane. Informational
features include Practice Points, Examples, Optional Workpapers, and Resources to help auditors work more effectively and
efficiently. You can also navigate from Resources within a document or the tip pane directly to CCH’s Accounting Research Manager
and industry audit guides by simply clicking on the reference.

Download Description

Version

2020 Knowledge-Based Audits of International Entities
Engagement and Knowledge Coach v2018 with CCH ProSystem fx Engagement v2018.2.4 Update or
later
OR
Engagement and Knowledge Coach v2019 or later
2019 Financial Statement Base

Release Date

October 2019

File size

18MB

Approx. Download Time

42 minutes at 56 kbps

License

Full Version

Platforms

Microsoft® Windows® 7, 8.1, 10

Office

Microsoft® Office 2013 or newer required
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